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Welke licenties bieden we aan voor SketchUp via SLBdiensten? 
 

SketchUp Pro educatieve netwerklicentie voor 12 maanden, concurrent use 
Met deze concurrent use netwerklicentie bestel je voor het maximaal aantal gelijktijdige gebruikers. 

Minimum bestelling is 10. Dit is geen subscription. Klant krijgt een serienummer en een 

authorisatiecode. 

SketchUp Studio voor Onderwijsinstellingen 
Licenties worden in een abonnementsvorm aangeboden en gekoppeld aan een e‐mail adres. 
Toewijzen van de licenties gebeurt via de SketchUp Accountmanagement Portal. Voor deze licentie 
gelden staffelprijzen: 10 ‐ 50 licenties / 51 ‐ 200 licenties / 201 ‐ 499 licenties / 500+ licenties. Per 
staffel geldt een andere prijs. Er geldt een minimum van 10 licenties. Bij een bijbestelling wordt er 
weer opnieuw gekeken in welk staffel de order valt. Een bijbestelling van 10 licenties valt in staffel 1 
(10 ‐ 50 licenties). Deze licentie kan ook voor thuisgebruik ingezet worden. 
 

SketchUp Studio ‐ Teacher subscription ‐ 1 year 
Een subscription voor een medewerker, activeren gaat via een Trimble ID: 

https://www.sketchup.nl/installatie‐activatie/195‐hoe‐activeer‐ik‐mijn‐subscription 

Veelgestelde upgrade vragen SketchUp Pro 2023 
 

Kan ik SketchUp Pro 2023 proberen als ik reeds SketchUp Pro 2022 heb 
geprobeerd? 
Jazeker, de demo‐versies zijn gereset. Dat betekent dat elke gebruiker die toegang heeft gehad tot 
de SketchUp Pro 2022 demo ook toegang kan krijgen tot de SketchUp Pro 2023 demo. 

 
Waar kan ik de volledige release notes inzien? 
De volledige release notes vindt u in de officiële SketchUp Help Section. 

 
Ik heb een Subscription. Hoe krijg ik toegang tot SketchUp Pro 2023? 
U heeft direct toegang tot de nieuwste versie via de AMP, in‐product upgrade notificatie of via een 
directe download link. Download SketchUp Pro 2023, installeer het op uw machine, activeer het met 
uw Trimble ID (TID) en u bent klaar om met SketchUp Pro 2023 aan de slag te gaan. 
 

Ik heb een geldige Classic License voor educatief gebruik. Hoe krijg ik toegang tot 

SketchUp Pro 2023? 

U kunt de nieuwe code om te upgraden naar de laatste versie van SketchUp bij SLBdiensten 
opvragen. 

Houd er rekening mee dat het activeren van uw SketchUp Pro 2023 Classic Licentie gevolgen heeft 
voor uw SketchUp Pro 2022 Classic Licentie. Een netwerklicentie van SketchUp Pro 2022 wordt na 
activatie van de 2023 licentie namelijk op ‘Pending’ gezet en zal 60 dagen na activatie niet meer 
opstarten. 
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Ik heb een Subscription. Kan ik nog steeds toegang krijgen tot SketchUp 2022 ook al 
is SketchUp 2023 er? 
Jazeker. Als u een actieve Subscription heeft, kunt u nog steeds SketchUp 2022 gebruiken, ook al is 
SketchUp 2023 beschikbaar. Eerdere versie op Subscription kan ook. 
 

Werken mijn Extensions wel met SketchUp 2023? 
Waarschijnlijk niet direct. Neem contact op met de leverancier van uw Extension om te zien of een 
update noodzakelijk is. Van de door ons ondersteunde Extensions is op dit moment de actuele 
status: 
Compatibel: 

 V‐Ray for SketchUp 
 Enscape 
 SU Podium 
 Undet 
 Artlantis 
 Thea for SketchUp 

Nog niet compatibel: 
 Podium Walker / ProWalker 
 RenderIN (Windows only) 
 Skimp 
 Profile Builder 
 Quantifier Pro 
 PlaceMaker 
 Skalp 
 Dibac 
 Skatter 
 Laubwerk 

 

Heeft SketchUp Pro 2023 nieuwe systeemeisen? 
U heeft minimaal een 64‐bit versie van Windows 10 of Windows 11 nodig. Voor macOS heeft u 11 
(Big Sur) 12 (Monterey) of 13 (Ventura) nodig. Eerdere versies worden niet meer ondersteund. 
Let ook goed op of uw computer wel voldoet aan de volgende hardware‐eisen: 

 2.1+ Ghz Intel Core processor 
 8+ GB RAM 
 1+ GB videogeheugen, OpenGL 3.1 of hoger 

 

Ik heb een Subscription 2022 geactiveerd op mijn computer (via inlog met Trimble 
ID). Kan ik versie 2023 tegelijkertijd op diezelfde computer activeren? 
Ja, dat kan. SketchUp 2022 en SketchUp 2023 zijn aparte programma’s en kunnen naast elkaar op uw 
computer draaien. 
Let op: 
Voor versies 2022 en 2023 gebruikt u dus twee activaties van uw Subscription. Als u merkt dat u 
daardoor op een andere computer niet meer kunt inloggen, log dan in één van beide versies uit. Als u 
geen toegang heeft tot het apparaat dan kunt u uitloggen via uw AMP. 
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Veel gestelde Subscription vragen 
 

Waarom zou ik een Subscription nemen? 
Steeds meer software wordt aangeboden in de vorm van een subscription en SketchUp Pro zal hierin 
meegaan. Bovendien dient een Subscription u meer functionaliteit ten opzichte van het klassieke 
licentiemodel, zoals: 

 Viewers voor de Hololens, Virtual Reality en Augmented Reality 

 Overal toegang tot de Premium Browser van SketchUp 

 Hoge resolutie geo‐locaties 

 Trimble Connect voor ongelimiteerde cloud‐opslag en ‐collaboratie 

 En wellicht nog meer in de nabije toekomst 
Bovenal is het een zorgenvrij licentiemodel. U heeft gedurende uw Subscription periode altijd recht 
op support en de laatste versie van SketchUp Pro. 

 

Wat gebeurt er als mijn Subscription afloopt? 
Als de subscription is afgelopen en niet tijdig verlengd is, dan heeft u geen toegang meer tot de 
premium functies van SketchUp Pro / Studio, zoals de desktop applicaties, Sefaira, e.d. U kunt uw 
modellen nog wel openen in de SketchUp Free webversie. De SketchUp Mobile Viewer is wel 
toegankelijk, al zal de Augmented Reality functionaliteit uitgeschakeld zijn. 
 

Zijn er ook mogelijkheden voor het floating / netwerkgebruik van Subscriptions? 
Nee, momenteel nog niet. Subscriptions zijn persoonsgebonden via een Trimble ID. 
 

Wat gebeurt er met mijn Trimble Connect data als ik niet mijn Subscription verleng? 
Data zal nooit worden verwijderd van Trimble Connect. Indien ze dat ooit van plan zijn, zal er ruim 
vooraf een aankondiging zijn met gegevens en richtlijnen over hoe lang de data beschikbaar zal 
blijven. 
 
 

Veel gestelde (netwerk)licentie vragen (educatieve netwerk licentie) 
 

Waar staan de actuele versies van SketchUp om te downloaden? 
https://www.sketchup.nl/download‐all 

 

Wat is er eigenlijk veranderd in de werking van licenties SketchUp Pro vanaf 2015? 
Wanneer u SketchUp Pro 2015 or later installeert, dan wordt nu de licentie geactiveerd over het 
internet. Dat betekent dat u uw licentie dient te de‐activeren wanneer u uw licentie overzet op een 
andere machine. Dit kan vanuit SketchUp Pro of zelfs het beginscherm. 
  

Hoe werken Netwerk Licenties in SketchUp Pro 2015 of later? 
In het algemeen worden netwerklicenties nu via het internet beheerd, niet meer lokaal op uw eigen 
netwerk. Wanneer u een netwerklicentie van SketchUp Pro 2015 of later installeert, dan wordt ook 
deze licentie via het internet geactiveerd. Er is dus geen lokaal bestand meer op uw eigen netwerk. 
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Wanneer u een netwerkversie van SketchUp Pro 2015 of later start, dan tikt deze een server aan via 
internet en laat zo weten dat de licentie in gebruik is. De server weet hoe vaak dit kan. Nadat 
SketchUp Pro 2015 of later wordt afgesloten op de client wordt de licentie weer vrijgegeven voor een 
andere gebruiker. 
  

Welke server‐toegang heeft SketchUp Pro nodig? 
Zorg ervoor dat u poorten 80, 8080, 443, 5053 en 50530 openzet in uw firewall voor SketchUp Pro. 
Plus, SketchUp Pro moet toegang hebben tot alle sub‐domeinen van SketchUp.com, eenvoudigweg 
toe te voegen als: 
*.sketchup.com 
 

Kan ik SketchUp Pro installeren zonder internetverbinding? 
SketchUp Pro stand alone / netwerk heeft een werkende internetverbinding nodig om de licentie te 
activeren. Heeft u echt geen werkende verbinding, bijvoorbeeld door extreme beveiliging, neemt u 
dan contact op met uw reseller. 
 

Kan ik SketchUp Pro starten zonder internetverbinding? 
 Een netwerkversie kunt u dan niet opstarten. 

 Een uitgecheckte netwerklicentie kunt u dan wel opstarten. 

 Ook een stand alone versie kan opgestart worden. 
  

Kan ik nog doorwerken in SketchUp Pro als het internet wegvalt? 
Ja, U kunt uw sessie gewoon afmaken. 
 

Kan ik een licentie meenemen uit het netwerk? 
Ja! Sinds SketchUp Pro 2015 of later kunt u netwerklicenties ‘uitchecken’ en meenemen op uw 
laptop bijvoorbeeld. Dat kan maximaal 7 dagen. 
 

Wat gebeurt er met mijn uitgecheckte licentie na 7 dagen? 
Dan wordt uw licentie weer teruggegeven aan de poule netwerklicenties. Op de machine waarop de 
uitgecheckte licentie staat kunt u SketchUp Pro dan niet meer opstarten zonder internetverbinding. 
 

Is er een manier om de licenties te managen, kijken wie welke in gebruik heeft, 

hoeveel er vrij zijn, uitgecheckt etc? 
Ja, dat is er. Maak een Trimble ID aan met hetzelfde email adres als die van uw SketchUp licentie. Log 

vervolgens in op http://license.sketchup.com en u kunt uw licentie monitoren. 

Veel gestelde vragen over Installatie en Activatie 
 

Ik heb SketchUp Pro / Studio gekocht, maar heb nog steeds een Trial  
Waarschijnlijk bent u in SketchUp Pro ingelogd met een ander e‐mailadres (Trimble ID) dan waarop u 
uw Subscription gekocht heeft. 
Log in met hetzelfde e‐mailadres. Vraag eventueel uw reseller naar het juiste e‐mailadres. Aan dit e‐
mailadres moet wel een Trimble ID gekoppeld zijn. 
Controleer als volgt of uw e‐mailadres al gekoppeld is aan een Trimble ID: 
 
Ga naar https://www.sketchup.com; 
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Klik rechtsboven op Sign In; 

 
 
Vul het e‐mailadres dat u wilt controleren en klik op Next. Er kunnen nu 3 dingen gebeuren: 
 
A. Er wordt om het wachtwoord gevraagd: het Trimble ID bestaat, is actief en u kunt hiermee 
inloggen in SketchUp Pro; 

 
 
B. Er staat dat het account nearly ready is: Klik op de link om de activatiemail nog eens te versturen. 
Controleer uw e‐mail (ook de map ongewenste reclame) en bevestig uw account. U kunt hiermee nu 
inloggen in SketchUp Pro; 
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C. Er wordt om een Naam en Wachtwoord voor het Trimble ID gevraagd. Er bestaat dan nog geen 
Trimble ID, volg de stappen deze aan te maken. Daarna kunt u hiermee inloggen in SketchUp Pro; 

 
 

Hoe autoriseer ik een netwerklicentie? 
Bekijk hier de volledige netwerkinstallatiegids 

Als netwerkbeheerder / systeembeheerder is het belangrijk de volgende instellingen in acht te 

nemen: 

Autoriseren van SketchUp als gebruiker 
U moet internettoegang hebben om SketchUp Pro 2015 of later te autoriseren. Voor de techneuten 

onder ons; als u SketchUp Pro autoriseert, communiceert SketchUp met de autorisatie‐server via de 

standaard TCP poorten 80 en 443. Als u een proxy of firewall gebruikt, staat u SketchUp Pro toe om 

te communiceren op die poorten naar het * .sketchup.com domein. 

Autoriseren van SketchUp met een netwerklicentie is niet anders dan autoriseren ervan met een 

licentie voor één gebruiker. Hoewel een netwerklicentie kan worden geautoriseerd op dezelfde 

manier als een single‐user licentie, is er één belangrijk voorbehoud voor succesvol gebruik van het 

netwerklicentie: TCP Poorten 5053 en 50530 moeten open zijn tijdens het actief gebruiken van een 

netwerklicentie. Raadpleeg uw netwerkbeheerder als deze poorten niet open zijn. 

Autoriseren van SketchUp in een netwerk als Administrator 
Als u SketchUp over een groter netwerk wilt distribueren, kunt u gebruik maken van het MSI‐

bestand) of een disk‐imaging pakket gebruiken, zoals Norton Ghost of Deep Freeze. In beide 

manieren van beide gedistribueerde installatiestrategieën, kunt u het autorisatieproces 

vereenvoudigen door het opnemen van een bestand dat het serienummer en autorisatie code voor 

de gebruikers invult, zodat ze niet zelf hoeven te typen. SketchUp Pro zal automatisch proberen om 

te autoriseren namens de gebruiker. 

Om deze procedure te gebruiken: 

1. Zorg ervoor dat SketchUp Pro 2015 of later is geïnstalleerd op alle computers. 

2. Maak een bestand met de naam activation_info.txt. U moet een tekstbewerker zonder 

opmaak gebruiken, zoals Notepad (Microsoft Windows) of TextMate (Mac OS X). 



 

10 
 

3. Typ in dat bestand uw netwerk serienummer en autorisatie code in het volgende formaat: 

{"serial_number":"YOUR SERIAL NUMBER", "auth_code":"YOUR AUTHORIZATION CODE", 

"allow_reactivation":true} 

4. Sla het bestand op en distribueer naar de volgende locatie op elke machine: 

 

Windows ‐ C:\ProgramData\SketchUp\SketchUp 201x 

Merk op dat het de verborgen ProgramData map betreft, niet de bekendere Program Files map. 

macOS ‐ /Bibliotheek/Application Support/SketchUp 201x 

Merk op dat dit de root‐level bibliotheek is, niet de gebruikersbibliotheek. 

U moet de SketchUp 201x map zelf maken. Er is niet standaard een SketchUp 201x map in de root‐

level map /Library/Application. 

5. Start SketchUp op elke machine of vraag uw gebruikers SketchUp Pro te openen. 

6. In het welkomdialoogvenster van SketchUp, klik op het tabblad License. Het serienummer en 

autorisatiecode moet nu vooraf zijn ingevuld in de velden met * symbolen, zodat de 

gebruiker niets hoeft in te typen. SketchUp Pro zal dan automatisch de verborgen licentie‐

informatie naar de autorisatieserver sturen. Zodra de licentie‐informatie wordt gevalideerd, 

zal SketchUp een uniek licentie‐bestand naar de computer van de gebruiker downloaden. 

 

Hoe kan ik SketchUp Pro licenties deactiveren? 
Een klassieke SketchUp Pro licentie of een SketchUp Pro Subscription is gekoppeld aan één persoon. 

Die persoon kan de licentie installeren op maximaal 2 computers die hij of zij gebruikt, maar slechts 

één computer kan SketchUp Pro tegelijkertijd gebruiken. 

Volg de volgende stappen om uw abonnement op een andere computer te gebruiken of een 

klassieke licentie over te dragen naar een nieuwe computer: 

Subscription 

Volg deze stappen om een klassieke SketchUp Pro licentie voor één gebruiker van een van uw 

computers te verwijderen: 

1. Klik op het poppetje rechtsbovenin in het Welkomstscherm 

2. Klik op 'Sign out'. 

3. Een webbrowser venster verschijnt met de tekst "You're signed out of all things SketchUp" 

Nu is een van uw twee autorisaties beschikbaar om te gebruiken op een andere computer. 
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Zie ook de screenshots hieronder: 

 

 

LET OP: u kunt uw SketchUp Pro Subcription ook deactiveren als de computer waarop die stond, niet 

meer beschikbaar is. Dit doet u als volgt: 

1. Ga naar uw Account Management Portal 

2. Log in 

3. Klik op 'My Products' voor uw gekochte Subscription Licentie 

4. Klik op de link 'Manage Devices'. 

5. Klik op de knop 'Deauthorize all'. 

Alle machines waarop u ingelogd was, zijn nu uitgelogd en u kunt inloggen op een nieuwe computer. 

Klassieke Licentie 

Volg deze stappen om een klassieke SketchUp Pro licentie voor één gebruiker van een van uw 

computers te verwijderen: 

1. Klik op 'License' in het Welkomstscherm 

2. Klik eventueel op het tabblad 'Classic'. 

3. Klik op de knop 'Remove License...' Er verschijnt een bevestigingsvenster.  

4. Klik op de knop 'Remove License' om te bevestigen dat u uw licentie echt wilt verwijderen. 

Nu is een van uw twee autorisaties beschikbaar om te gebruiken op een andere computer. 

Zie ook de screenshots hieronder. 

LET OP: u moet uw SketchUp Pro licentie daadwerkelijk van uw computer verwijderen om de licentie 

aan een nieuwe machine te kunnen koppelen. Als u SketchUp Pro verwijdert zonder uw licentie te 

verwijderen, kunt u de licentie niet aan een nieuwe machine koppelen. 

Als u SketchUp op méér dan twee computers tegelijk moet uitvoeren, kunt u overwegen aanvullende 

licenties voor één gebruiker of abonnementen aan te schaffen. 
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Hoe kun je SketchUp Pro verwijderen of repareren? 
Let op; deactiveer uw SketchUp Pro licentie vóórdat u SketchUp Pro deïnstalleert. Lees hier hoe u dat 

doet. 

Windows 

1. Sluit SketchUp af. (Als u meer dan één instantie van SketchUp heeft geopend, zorg er dan 

voor dat u alle instanties van SketchUp afsluit.) 

2. Klik op het menu Start (Windows‐logo) > Configuratiescherm > Programma's > Programma's 

en onderdelen > SketchUp 20##. 

3. Selecteer Verwijderen 

4. Klik op Ja als u wordt gevraagd of u SketchUp wilt verwijderen. 

5. Ga naar de (verborgen) map Lokale schijf (C:)>ProgramData/SketchUp/ en verwijder de map 

SketchUp 20## 

6. Ga naar de (verborgen) map %AppData%/Roaming/SketchUp en verwijder de map SketchUp 

20## 

7. Ga naar de (verborgen) map %AppData%/Local/SketchUp en verwijder de map SketchUp 

20## 

Let op: Als u problemen heeft met SketchUp, kunt u de optie Wijzigen proberen, waarmee het 

proces begint van het opnieuw installeren van de programmafuncties die tijdens de laatste installatie 

zijn geïnstalleerd. Dit kan alle applicatiebestanden repareren die beschadigd zijn (dit heeft geen 

invloed op of repareer uw SketchUp‐tekenbestanden, de SKP‐bestanden). Als dat niet werkt, probeer 

dan SketchUp te verwijderen en opnieuw te installeren. 
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Mac 

1. Sluit SketchUp af. 

2. Open een Finder‐venster en ga naar de Apps folder (Programma map). 

3. Sleep de SketchUp 20## folder in de prullenmand 

4. In Finder>Ga> Ga naar map... en type '~/Bibliotheek/Application Support/SketchUp' en 

verwijder de map SketchUp 20## 

5. In Finder>Ga>Ga naar map... en type '/Bibliotheek/Application Support' en verwijder de map 

SketchUp 20## 

Let op: Als u problemen heeft met SketchUp, kunt u ervoor kiezen die opnieuw te installeren. Wees 

er zeker van dat SketchUp is afgesloten. 

 

Hoe activeer ik mijn Subscription? 
Activeer uw SketchUp Subscription via onderstaande stappen! Of bekijk het filmpje. 

A. Als u nog geen Trimble ID heeft (of als u de licentie aankoopt op een andere Trimble ID dan de 

ID die u reeds heeft) 

 

Als u al een Trimble ID heeft, ga direct door naar stap B. 

‐ Hoe weet ik of ik een Trimble ID heb? 

1. Controleer de mail op het e‐mailadres dat u opgaf voor uw Subscription; 

U ontvangt een e‐mail van noreply_identity@trimblepaas.com, met het onderwerp "Trimble 

Account Creation Notification” 

 

2. In de e‐mail klikt u op de knop Activate account 

 

U wordt naar een website doorgestuurd 

 

3. Voer hier uw e‐mailadres in en kies een wachtwoord 

 

U heeft nu een actief Trimble ID account, ga verder met stap B. 

Wat als ik niet op de activatielink heb geklikt voordat de 72 uur voorbij waren? 
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B. Als u een actief Trimble ID heeft 

Controleer de mail op het e‐mailadres dat u opgaf voor uw Subscription; 

U ontvangt een e‐mail van noreply_identity@trimblepaas.com met het onderwerp “Your subscription 

for SketchUp Pro/Studio/..., annual termed contract is here” 

 

Controleer eventueel uw spam folder of ongewenste mail. 

Als u deze mail niet gehad heeft, is uw licentie nog niet toegewezen en moet u stap C volgen: 

 

C. Wijs uw licentie toe 

Als u maar één licentie heeft gekocht, kunt u deze stap overslaan, uw licentie is automatisch 
toegewezen. 
Ga direct door naar stap D. 
Als u méér dan één licentie heeft gekocht, moet u deze stap altijd volgen. 

1. Log in op uw Account Management Portal 

LET OP: gebruik het e‐mailadres waarop u de subscription heeft gekocht, om in te loggen! 

LET OP: gebruik de gele knop van Trimble om in te loggen! Het kan zijn dat u eerder een 

Trimble ID hebt aangemaakt via uw Google Account of Apple ID, maar dat is niet het Trimble 

ID waaraan het lidmaatschap wordt gekoppeld. (Google heeft andere wachtwoordeisen en 

Apple kan een dummy‐e‐mailadres gebruiken als de optie ‘Hide my mail address’ is gebruikt) 
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Kies het account waar bij staat ‘Purchased via….’ 

 

 
 

Eenmaal ingelogd, kunt u nog van account wisselen aan de linkerkant: 

 

 

2. Klik dan op de tab Members onder “Purchased via ……” (Naam van uw Reseller) 

Check of hier het email adres erbij staat en of die toegang heeft (Product Access): 

 

 
 

U kunt hier ook een ander e‐mailadres toevoegen, voor als u bijvoorbeeld het huidige niet 
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meer gebruikt. De portal biedt ook de mogelijkheid om meerdere Subscriptions te regelen 

voor als u die hebt. In dit voorbeeld hebben we Mike Wayzovski toegevoegd, maar zoals u 

ziet heeft die geen product van ons gekregen! In dit voorbeeld is de James de Account Owner 

en hij heeft ook toegang tot het product! 

D. Download en installeer SketchUp 

Als u SketchUp Pro 202x al geïnstalleerd heeft hoeft dit niet opnieuw, ga dan door naar stap E. 

1. In dezelfde portal en ingelogd met het emailadres wat het product heeft (Product Access in 

de stap hiervoor) kunt u aan de linkerkant naar ‘My Products’ gaan: 

 

 

2. View included apps: 

 

 
 

Kies de juiste versie voor uw systeem (Windows of Mac) Bij de knop ‘Manage Devices’ kunt u 

alle machines ‘de‐autoriseren’ voor als u de melding krijgt dat er op te veel machines is 

geactiveerd. 

o Installatie op Windows 

o Installatie op Mac 

 

E. Start SketchUp Pro en Log in met uw Trimble ID 

SketchUp Pro opstarten op een Windows PC doet u door dubbel te klikken op de snelkoppeling die 

automatisch op uw bureaublad staat na het installeren van SketchUp Pro. 



 

17 
 

Op macOS start u SketchUp Pro door de programmamap “SketchUp 202x” op te zoeken in de map 

'Apps' of via de ‘Launchpad. U kunt de iconen ook naar uw Dock slepen zodat u ze snel tot uw 

beschikking heeft. 

Na het opstarten dient u in te loggen met het e‐mailadres wat de juiste ‘Product Access’ heeft! 

 

Hoe weet ik of ik al een Trimble ID heb? 
U heeft een Trimble ID als u 

 Kunt inloggen op het 3D Warehouse 

 Kunt inloggen op het Extension Warehouse 

 Gebruik maakt van SketchUp Free 

 Gebruik maakt van Trimble Connect 

 Een trial van SketchUp 202x aangevraagd heeft 

Mijn activatielink is verlopen, wat nu? 
In de activatie‐e‐mail staat dat u binnen 72 uur op de activatielink moet klikken. Heeft u te lang 

gewacht, dan kunt u echter nog steeds op de activatielink klikken... echter er gebeurt dan nét even 

iets anders. U vult (net als eerst) uw gegevens in, maar vervolgens zal de Trimble ID website 

vermelden dat uw link verlopen was. 

 
U moet hier op 'forgot password' klikken en uw e‐mail adres nogmaals invullen. U krijgt dan een 

nieuwe activatie‐e‐mail. 

Bekende fouten: 

Nog Steeds in Trial: 
Staat er in het welkomstscherm nog steeds een Trial periode? Log dan eerst uit, stop SketchUp en 
start weer op. Log dan weer in met uw Trimble ID. 
 

Het Welkomstscherm zegt "Trial expired", maar ik heb een subscription! 
Indien u niet meer via het Welkomstscherm naar uw Account Management Portal kunt volg dan de 
stappen vanaf Stap C. 



 

18 
 

 

Ik heb meerdere subscriptions, hoe verdeel ik die? 
U kunt meerdere subscriptions inkopen, het e‐mailadres waar u die aankoop op doet, wordt de 
Account owner. U kunt bij het ‘Members’ gedeelte ook meerdere gebruikers toevoegen en kiezen 
welke rol zij krijgen: Company Admin of Product user. 
De Company Admin kan ook gebruikers toevoegen als die inlogt met zijn Trimble ID en het account 
kiest dat hem is toegewezen door de Account Owner. Toegevoegde gebruikers met de rol ‘Product 
user’ zien alleen hun product in de Account management portal, zodat die zelf SketchUp Pro kunnen 
downloaden of hun Devices moeten de‐authoriseren. (Account owners en Company Admins kunnen 
dat niet voor hen doen.) 
Tijdens het toevoegen van de gebruikers kunt u het product alvast toewijzen, of dit later doen of 
wijzigen: 
 

 
 
Let op: Een SketchUp Subscription is persoonlijk, dus op naam van de gebruiker. Indien het een 
nieuw Trimble ID is, dient deze nog te worden geactiveerd! 

 

 

Beheren van uw SketchUp abonnement 
U kunt een abonnement hebben voor SketchUp Pro en SketchUp Studio. Als u hebt betaald voor het 
abonnement is deze geldig voor de duur die vermeld staat op uw factuur. Meestal is dit een jaar. 

 

Het checken van uw abonnement 
 U kunt de status van uw abonnement controleren vanuit SketchUp. Om dit te doen moet u 

het volgende doen: 

 Selecteer in het [Menu] Help‐ Manage License 

 Selecteer het Subscription tabje, Zolang uw abonnement actief is wordt dit aangegeven in 
het venster. Daar wordt ook aangegeven wanneer het abonnement afloopt. (expires) 

 Aanvullend wordt er nog meer informatie weergegeven via het knopje linksonder (Manage 
License) 

 
 

Hoe vaak mag ik een licentie SketchUp Pro activeren? 

 
Subscription 
Volgens de licentievoorwaarden behoort een subscription toe aan één gebruiker. Deze persoon mag 
de subscription op 2 van zijn / haar computers activeren, bv. een desktop op kantoor en laptop voor 
klantbezoek. 
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Standalone licentie 
Volgens de licentievoorwaarden behoort de licentie toe aan één gebruiker. Deze persoon mag de 
licentie op 2 van zijn / haar computers installeren, bv. een desktop op kantoor en laptop voor 
klantbezoek. 

 

Netwerklicentie 
Een netwerklicentie heeft geen beperking wat betreft het aantal activaties en toegewezen personen. 

De licentie mag u op alle systemen binnen uw organisatie activeren. Het aantal seats wat uw 

netwerklicentie bepaalt hoeveel gebruikers u gelijke tijd actief kunt hebben. Bijvoorbeeld met een 

netwerklicentie van 5 seats kunnen er maximaal 5 medewerkers op hetzelfde tijdstip in SketchUp Pro 

werken. 

 

Trimble Identity ‐ Veelgestelde vragen 
 
Trimble Identity biedt single‐sign‐on toegang voor alle SketchUp Online‐services. U kunt zich bij één 
dienst aanmelden en vervolgens bladeren naar een andere online service zonder dat u zich opnieuw 
hoeft aan te melden. 
 

Hoe maak ik een Trimble‐identiteit aan? 
Wanneer u een Trimble ID maakt, kunt u een gebruikersnaam rechtstreeks met uw e‐mailadres 
maken of kunt u zich aanmelden met uw Google‐account. 
 
Als u een Trimble ID wilt maken, gaat u rechtstreeks naar de Trimble ID‐accountbeheerpagina en 
volgt u de stappen voor het maken van het account. U kunt ook SketchUp openen of u kunt een 
SketchUp‐site zoals het 3D Warehouse bezoeken en op "Sign in | Create Account" klikken. Nadat uw 
account is gemaakt, kunt u de bovenstaande link gebruiken om wijzigingen aan te brengen in uw 
account. 
 
Zodra u bent ingelogd op een aanmeldingspagina, volgt u gewoon de stappen om uw account te 
maken. 

1. Begin met het invoeren van uw gewenste e‐mailadres in het juiste veld. 
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2. Als het e‐mailadres al is gebruikt om een Trimble ID te maken, ziet u een optie om uw 

wachtwoord in te voeren of een vergeten wachtwoord op te vragen. 

 

3. Als het e‐mailadres nooit is gebruikt, ziet u opties om een account aan te maken. U voert hier 

uw naam in en kiest een wachtwoord. Vergeet niet om onomstotelijk te bewijzen dat u geen 

robot bent. U ontvangt vervolgens een e‐mail waarin u wordt gevraagd om uw account te 

activeren. Doe dit binnen 72 uur. 

 

4. Klik op de link in de e‐mail om uw Trimble ID te maken. 

 

Opmerking: als u zich aanmeldt met uw Google‐account, klikt u gewoon op de knop 'Inloggen met 

Google'. Voer de inloggegevens voor uw Google / Gmail‐account in als daarom wordt gevraagd. 

 

Handleiding Trimble ID 
https://www.sketchup.nl/installatie‐activatie/195‐hoe‐activeer‐ik‐mijn‐subscription 
  

 

Filmpje hoe je snel aan de slag kunt met SketchUp Subscription d.m.v. een Trimble 

ID: 
https://www.youtube.com/watch?v=_W6NqPkMiTg&t 
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Hoe kunnen studenten samenwerken via Trimble Connect? 
Iedereen met een Trimble ID kunt u uitnodigen op een project. Handel als volgt: 
1. Login op https://connect.trimble.com (Trimble ID nodig)  
2. Maak rechtsboven een nieuw project aan  
3. Nodig de studenten uit op dit project  
4. Deel modellen en documenten in dit project  
Ik heb hier wat instructies Trimble Connect verzameld:  
https://www.youtube.com/watch?v=65fKXBaj8KM 
Desktop ‐tutorial:  
https://www.youtube.com/watch?v=RB_Jv4tMdlU 
Mobile ‐tutorial:  
https://www.youtube.com/watch?v=EKdUfQLMb54 
 

Probleemoplossen 

Ik heb een Trimble ID gemaakt maar kan me niet aanmelden. Waarom? 
Waarschijnlijk is uw Trimble ID niet geactiveerd. Wanneer u een Trimble ID maakt, ontvangt u een e‐
mail met de vraag om uw account te activeren. Deze stap bevestigt dat uw e‐mailadres correct is. Klik 
op de link in de e‐mail om uw account te activeren. Hierna zou u moeten kunnen inloggen met uw 
Trimble ID‐inloggegevens. U heeft 72 uur om uw account te activeren. Als u uw account niet binnen 
72 uur hebt geactiveerd, moet u de link 'Forgot password' gebruiken om uw wachtwoord opnieuw in 
te stellen en uw account te activeren. 
 

Ik ben mijn Trimble ID‐wachtwoord vergeten 
Voer op de Trimble ID‐aanmeldingspagina uw e‐mailadres in en klik op Volgende. Er verschijnt een 
venster waarin u uw wachtwoord kunt invoeren of op "Forgot password?" kunt klikken. 

 
Vul uw e‐mailadres in en klik op de link Wachtwoord opnieuw instellen. 
Controleer uw e‐mailinbox voor e‐mail van de Trimble ID‐service. Klik in het e‐mailbericht op de knop 
Wachtwoord opnieuw instellen om een nieuw wachtwoord voor uw Trimble ID in te stellen. 

 

Trimble vraagt me een geldig e‐mail adres in te voeren 
Ik heb geprobeerd mijn wachtwoord opnieuw in te stellen, maar Trimble ID herkent mijn e‐mailadres 
niet en vraagt mij om een geldig e‐mailadres in te voeren. 
Ik zie een foutmelding die zegt: "Sorry, we hebben deze gebruiker niet herkend. Voer een geldig e‐
mailadres in." Als de spelling van het e‐mailadres correct is, betekent dit dat u momenteel geen 
Trimble ID heeft. Voer uw gewenste e‐mailadres in op de inlogpagina en ga verder en u gaat naar een 
venster dat u kunt gebruiken om een Trimble ID te maken. 
 

Ik heb geen e‐mails ontvangen van Trimble ID. 
De firewall van uw bedrijf blokkeert mogelijk onze e‐mails of wordt mogelijk geblokkeerd door uw 
spamfilter. Neem contact op met uw IT‐afdeling en vraag hen e‐mails toe te staan van 
*@trimble.com en *@trimblepaas.com en *@mail.trimblepaas.com. U kunt onze e‐mail mogelijk 
ook vinden in uw map Spam. Zorg er wel voor dat u de bovenstaande e‐maildomeinen op de witte 
lijst plaatst. 
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Trimble ID accepteert mijn wachtwoord niet 
Ik heb geprobeerd een nieuw wachtwoord in te voeren, maar Trimble ID accepteert dit niet. 
Waarom? 
Om veiligheidsredenen moet het wachtwoord ten minste het volgende bevatten: 

 8 tekens 

 Ten minste één cijfer [0‐9] 

 Een combinatie van hoofdletters en kleine letters [aA‐zZ] 

 Ten minste één speciaal teken [! @ # $% & * ^ _‐ +] 
 

Gebruik 

Hoe zet ik al mijn instellingen, materialen, componenten en extensies over naar een 

nieuwe versie SketchUp Pro? 
 

Instellingen 

Mac 

 Shortcuts ‐ Als het goed is, zijn shortcuts automatisch gekopieerd van SketchUp Pro 2022 

naar SketchUp Pro 2023. 

Is het niet automatisch gebeurd? In ~Library/Application 

Support/SketchUp20xx/SketchUp vindt u een bestand met de 

naam SharedPreferences.json waarin onder andere de sneltoetsen opgeslagen zijn. In dit 

zelfde bestand worden ook een heel aantal instellingen uit het Preferences venster 

opgeslagen. In versies 2017 en eerder werden de shortcuts opgeslagen in het 

bestand Shortcuts.plist. Beide soorten bestanden zijn met een eenvoudige teksteditor te 

openen en eventueel te bewerken, maar informatie uit een plist bestand is niet 1 op 1 te 

kopiëren naar het json bestand ‐ het is eenvoudiger om uw sneltoetsen opnieuw in te stellen. 

 Templates ‐ Als het goed is wordt de template die u in SU2022 gebruikte, ook weer gebruikt 

in SU2023. 

De map Templates in ~Library/Application Support/SketchUp20xx/SketchUp wordt 

automatisch gekopieerd naar de nieuwe installatie. Mocht dit om één of andere reden niet 

automatisch gebeurd zijn, dan kunt u dit handmatig doen, en vervolgens de template via het 

startscherm kiezen als de template waarmee u wilt opstarten.(Geef het een hartje) 

Als de map ~Library/Application Support/SketchUp201x/SketchUp/Templates niet bestaat, 

betekent dit dat er nog nooit een template is opgeslagen via File>Save as template… 

 Knoppenbalken ‐ De posities en status van knoppenbalken wordt opgeslagen in het 

bestand PrivatePreferences.json. Let wel op dat dit vooral knoppenbalken van Extensies 

betreft, en dat het pas nut heeft dit bestand te kopiëren als desbetreffende extensies 

geïnstalleerd zijn. U vindt dit bestand in ~Library/Application 

Support/SketchUp201x/SketchUp 

Windows 

 Shortcuts ‐ Als het goed is, zijn shortcuts automatisch gekopieerd van SketchUp Pro 2022 

naar SketchUp Pro 2023. 

Is het niet automatisch gebeurd? Open dan SketchUp Pro 2022, ga naar Window > 
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Preferences > Shortcuts en klik op de knop "Export...". Sla het data‐bestand op waar u het 

terug kunt vinden. Open dan SketchUp Pro 2023, ga naar Window > Preferences > Shortcuts, 

klik op de knop "Import..." en zoek het bestand op dat u in de vorige stap heeft opgeslagen. 

 Templates ‐ Als het goed is wordt de template die u in SketchUp 2022 gebruikte, ook weer 

gebruikt in SketchUp 2023. 

De eigengemaakte templates uit versie 2022 zouden automatisch gekopieerd moeten 

worden naar C:\Program Files\SketchUp\SketchUp 2020\Resources\en‐US\Templates. Is 

dit niet automatisch gebeurd, dan kunt u dit zelf handmatig doen. Vervolgens kunt u de 

template via Window > Preferences > Templates kiezen als de template waarmee u wilt 

opstarten. 

 Knoppenbalken ‐ De posities en status van knoppenbalken wordt opgeslagen in het bestand 

PrivatePreferences.json. Let wel op dat dit onder andere knoppenbalken van Extensies 

betreft, en dat het pas nut heeft dit bestand te kopiëren als desbetreffende extensies 

geïnstalleerd zijn. U vindt dit bestand in C:\Users\[uw 

gebruikersnaam]\AppData\Local\SketchUp\SketchUp 2023\SketchUp 

Materialen 

Mac 

Kopieer de map met zelf gecreëerde materialen van ~Library/Application 

Support/SketchUp2022/SketchUp/Materials naar ~Library/Application 

Support/SketchUp2023/SketchUp/Materials indien dit niet automatisch gebeurd is. 

Windows 

Voeg indien nodig de mappen waarin u uw materialen opslaat, opnieuw toe aan de favorieten via het 

materialenvenster: Window > Materials > pijltje aan de rechterkant > Add collection to favorites… 

Componenten 

Mac 

De lijst met favoriete component‐mappen in SU2023 wordt automatisch overgenomen van de lijst 

met favorieten van SU2022. 

Mocht dit niet automatisch overgenomen zijn tijdens de installatie, wijs dan opnieuw de mappen aan 

via het menu Details in het componentenvenster: Window > Components > pijltje aan de rechterkant 

> Open a local collection… In dit venster staat automatisch ook de optie 'Add to favorites' aan, 

waardoor u de map de volgende keer niet opnieuw zelf hoeft op te zoeken. 

Windows 

De lijst met favoriete component‐mappen in SU2023 wordt automatisch overgenomen van de lijst 

met favorieten van SU2022. 

Mocht dit niet automatisch overgenomen zijn tijdens de installatie, wijs dan opnieuw de mappen aan 

via het menu Details in het componentenvenster: Window > Components > > Open or create a local 

collection… 

Vervolgens voegt u de map die u geopend hebt, aan de favorieten toe, zodat u hem de volgende keer 

niet opnieuw hoeft op te zoeken: Window > Components > > Add to favorites… 

Extensies 
Iedere versie van SketchUp verbetert weer iets aan de implementatie van extensies binnen 

SketchUp. Echter, die verbetering betekent soms ook dat er iets gewijzigd dient te worden in de code 
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van een extensie, en dat sommige extensies niet automatisch compatibel zijn met de laatste versie 

van SketchUp. 

SketchUcation.com 

De Plug‐in store van SketchUcation biedt de mogelijkheid tot updaten wanneer u ingelogd bent. Klik 

op de tandwieltjes bovenin, daar kunt u zien welke plug‐ins u eerder gedownload hebt en ze 

automatisch laten installeren. 

Extension Warehouse 

Extensies die u in versie 2023 heeft gedownload via het Extension Warehouse kunt u herinstalleren 

via het Extension Warehouse. Echter, recentelijk heeft het extension warehouse een complete 

overhaul gekregen, waardoor enkel nog de betaalde extensies nog in uw account te zien waren. 

Download deze door in te loggen rechtsboven in het extension‐warehouse‐scherm. De rest van de 

extension‐warehouse‐extensies kunt u opnieuw opzoeken door hun naam in te typen in de zoekbalk. 

Render‐Extensies: 

De meeste render‐plug‐ins zijn geactualiseerd om nu ook te werken met versie 2020. Over het 

algemeen dient u deze plug‐ins te updaten via een installatiebestand van de makers zelf. 

 V‐Ray 

Chaosgroup heeft een geactualiseerde versie uitgebracht. Gelicenseerde gebruikers kunnen 

hun bestanden enkel verkrijgen via de website van chaosgroup.com nadat ze ingelogd 

zijn. Via onze website kunt u de demoversie aanvragen. 

 SU Podium 

Download uw installer hier. 

 Artlantis 

Download de geactualiseerde exporters van SketchUp naar Artlantis hier. 

 RenderIN 

Download de compatibele versie van RenderIN hier. 

Overige Extensies 

Ga naar het voorkeurenvenster Via het menu SketchUp>Preferences. Klik daar op het onderwerp 

'Extensions'. Hier kunt u klikken op de knop 'Install Extension…'. Installeer op deze manier overige 

plug‐ins die u niet via één van bovenstaande methodes heeft kunnen updaten. 

Bij deze optie kunnen we natuurlijk niet garanderen dat de plug‐ins ook zullen werken, evenmin als 

bij de volgende: 

Mac 

Mocht u nog een plug‐in hebben die enkel als RB‐bestand geleverd is in plaats van RBZ‐bestand, dan 

kunt u het handmatig kopiëren naar de map ~Library/Application 

Support/SketchUp20xx/SketchUp/Plugins Let op dat er soms een bijbehorende map is, die moet u 

dan ook kopiëren. 

Windows 

Mocht u nog een plug‐in hebben die enkel als RB‐bestand geleverd is in plaats van RBZ‐bestand, dan 

kunt u het handmatig kopiëren naar de map C:/Users/ [uw 

gebruikersnaam]/AppData/Roaming/SketchUp/SketchUp 20xx/SketchUp/Plugins . Let op dat er 

soms een bijbehorende map is, die moet u dan ook kopiëren. 
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Alles over het Account Management Portal 
Het Trimble Account Management Portal (AMP) helpt u bij het beheren van uw Trimble 
abonnementsproducten voor SketchUp Studio. Met de AMP kunnen accounteigenaren en 
bedrijfsbeheerders de details van hun abonnementen bekijken, gebruikers toevoegen of verwijderen 
en abonnementsplaatsen toewijzen of intrekken. Alle SketchUp‐gebruikers kunnen de AMP 
gebruiken om hun toegewezen producten te downloaden en hun apparaatactiveringen te beheren. 
 

Meer informatie over het Account Management Portal is te vinden via de volgende link: 
https://help.sketchup.com/en/admin/account‐management 
 

Wat zijn de systeemeisen van SketchUp Pro? 
 
Apple macOS 

 
Software: 

 macOS 11, 12 of 13 
 WebGL compatibele web browser 

Microsoft Windows 

 
Software: 

 Windows 10 of 11 ‐ 64 Bit 
 WebGL compatibele web browser 

 
Hardware 
Minimale systeemeisen: 

 2.1+ GHz processor of Apple M1 processor 
 4 GB RAM 
 500 MB schrijfruimte 
 Videokaart 1+ GB 100% OpenGL 3.1* 
 3‐knops muis met scrollfunctie 

Aanbevolen systeemeisen: 
 2.4+ GHz processor of Apple M1 processor 
 8 GB RAM 
 1 GB schijfruimte 
 Videokaart 2+ GB 100% OpenGL 3.1* 
 3‐knops muis met scrollfunctie 

 
Let op: Er is geen Linux versie van SketchUp Pro beschikbaar en Windows 8 / macOS 10.14 en eerder 
worden niet langer ondersteund! 
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Videokaart 
* Indien u een nieuwe machine overweegt, besteed dan voldoende middelen aan de videokaart. Wij 
raden kaarten aan met een RTX chip, bij voorkeur uit de GeForce serie. Deze kaarten ondersteunen 
OpenGL zeer goed en hebben kwalitatief goede drivers. OpenGL is het hart van de 3D weergave voor 
SketchUp Pro. On‐board videokaarten (opgesoldeerde chipsets) worden ten zeerste afgeraden! 
Twijfelt u over de aanschaf van een nieuwe videokaart, bekijk dan ook zeker deze benchmark (bij 
voorkeur high‐end). 
 
Systeem Check‐Up Tool 
Bij twijfel over uw systeem, kunt u hier een speciale check‐up tool downloaden, die uw systeem test 
op de juiste configuratie. 
 

Is SketchUp ook geschikt voor Mac? 
Jazeker, SketchUp Pro draait op zowel Windows als Mac computers (geen Linux). 
De eerlijkheid gebiedt ons te zeggen dat bij zwaardere modellen met veel texturen en complexe 
stijlen, Windows sneller is dan Mac. 
Vaak wordt gezegd dat de Magic Mouse van Apple niet geschikt is voor SketchUp Pro, maar niets is 

minder waar. 


